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Copyright Notice 

 
You may not reproduce, transmit, transcribe, store in a retrieval system or translate into any human or 
computer language this manual and software. These actions, in any form or by any means, are illegal 
without the express written permission of Puritas Springs Software. 

 
 

Limited Warranty 
 
During the period of time before a major upgrade, if the disk(s) that make up the then-current version 
of this software are defective, the original purchaser may return the software to Puritas Springs Soft-
ware, 645 McKee Trail, Hinckley, Ohio 44233-9209 and replacement disk(s) will be mailed to you. 
Puritas Springs reserves the right to define and decide what constitutes a major upgrade. 
 
 
 

Disclaimer & Limitations 
 

Puritas Springs Software provides Ohio Workers Compensation for Windows, consisting of both the 
software and this manual, "AS IS." The software and manual carry no warranty as to performance, 
merchantability or fitness for any particular use. Puritas Springs Software specifically disclaims all 
warranties, express or implied, regarding the software or our services, and Puritas Springs Software 
does not warrant that the software or services are free from defects, interruption, errors or other pro-
gram limitations. For states that have limitations on implied warranties, any such implied warranties 
are limited to 60 days from the date of purchase. The rights provided by this Limited Warranty shall 
be limited to the original, registered and recorded purchaser of the software. Said rights are limited to 
the cost of the software and are non-transferable.  You assume all liability and responsibility for the 
accuracy of any form produced by this software. Recognizing this, Puritas Springs Software has 
exercised due care in the preparation of the software and manual. In no event, however, shall the au-
thors or publisher be liable for direct, incidental or consequential damages, or damages of any type, 
arising from the use of Ohio Workers Compensation for Windows. 
 
This Agreement together with the Licensing Agreement you accept during installation sets forth Pu-
ritas Springs Software’s entire liability and your exclusive rights and remedy with respect to the 
software. Headings are included for convenience and shall not be considered in interpreting this 
Agreement. This Agreement does not limit any rights that Puritas Springs Software may have under 
trade secret, copyright, patent or other laws, federal or state. 
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Ohio Workers Compensation—Injured 
Workers Forms—Version 2+ (WComp2) 
is a true 32-bit Windows program that runs 
on any computer equipped with Windows 
Vista, Windows XP, Windows 2000, Win-
dows ME, and Windows 98.  
 
Installation—In General 
 
Install Ohio Workers Compensation—Injured Workers Forms (WComp2) to your 
hard drive by following the steps outlined below. Before starting the installation, we 
should mention that the files on the distribution CD are compressed, and therefore, 
you must “install” WComp2 to your computer rather than simply copying the files 
from the CD to your hard drive. For that same reason, you cannot run WComp2 
from the CD. You must install WComp2 to your hard drive. 
 
Installation—Steps 

 
A.  Place the disk in your drive. 
 
B.  On most systems, depending on your license, installation will begin automati-
cally, however, if the installation wizard does not start automatically, take the 
following three steps: 
 

1. Press the Start button; 
 
2. Click on the Run item; and 
 
3.  Type the command shown below. Note that if you’re installing from a dif-

ferent drive, you must use the correct drive letter, i.e., “E:\SETUP”. 
 

D:\SETUP.EXE 
 

C. The Setup progress meter will appear briefly until the Welcome dialog dis-
plays. Click the Next button to begin the installation. Follow standard Win-
dows installation protocol by making sure all other applications are turned 
off—not just minimized, but terminated. Click Cancel if you want to abort in-
stallation. 

 
D.  The Puritas Springs Software Licensing Agreement appears in the next dia-

log. Press the Yes button to accept the terms and conditions of the license and 
continue with the installation. If you do not agree to the terms of the Licensing 
Agreement, you will not be able to continue installing the program. 
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E. Verify your user identification information and click the Next button. 
 
F.   The Setup Type dialog will appear next. Here you must select the Setup type. 
There are two to choose from: (1) Typical, where all programs features will be in-
stalled (This requires the most disk space), and (2) Without Registry Settings, 
where WComp2 is installed without affecting the registry. This alternate setup is used 
when reinstalling WComp2 on a network. It keeps the Default WC2 and WCM file 
locations intact on the Options menu. If you’re not reinstalling on a network, choose 
Typical and click on the Next button to continue.  
 
G. Verify the installation directory. We strongly recommend using C:\Program 
Files\Puritas\WComp2 which is the default. If you want to use an alternate instal-
lation directory or drive, you can use the Change button to make your selection. 
Click the Next button to continue. WARNING: Changing the default installation 
directory will require corresponding adjustments to the default file locations on 
the Options menu. 
 
H.  The installation begins when you click the Install button in the Ready to Install 
the Program dialog. A progress meter will keep you informed as the program files 
are transferred from the CD to your hard drive. 
 
I.  When the entire installation process is complete, the InstallShield Wizard Com-
pleted dialog advises you that the installation process was successfully completed. 
Click on the Finish button. 
 
Running WComp2 
 
You start WComp2 by (1) double-clicking the WComp2 icon on the desktop, or (2) 
clicking on the Start button, selecting the Programs submenu, then selecting the Pu-
ritas Springs Software submenu, and finally the WComp2 item.  
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Updating and Reinstallation 
 

1. Download the Upgrade. 
A. Click on WComp2’s Help menu and select Download Upgrade. 

B. In the Download Upgrade dialog box, click on the Check Availability but-
ton. Note that some systems, typically networks, may have security software 
and/or hardware in place that prohibit downloading executable files. If this is 
true in your office or you are having problems with the download, check with 
your network administrator. 

C. After clicking the Check Availability button, you may get one of three re-
sponses. 

1) You are notified that a newer version is available and the Check Avail-
ability button changes to a Download Upgrade button. Click on 
Download Upgrade button and see the file downloading. 

2) You are notified that there is no newer version available, in which case, 
you’re done. 

3) A message indicates an error, ie., “HTTP Get Failed.” Talk with your 
network administrator or send in your disk according to our instructions 
on the Current Versions page of our web site: www.puritas-springs.
com. 

2. Remove WComp2. First, it is important to know that removing the WComp2 
program using Windows’ Add/Remove function will not delete or harm 
your client files. That being said, you should always back up the Files subfolder 
that is contained within the WComp2 program folder. It is there that your client 
files are stored. The default path is C:\Program Files\Puritas\WComp2\Files\. 
Here are the steps for removing the prior version of WComp2. 

A. Exit the WComp2 program. 

B. Click on the Start button. From the Start menu select Settings, and then 
Control Panel. Note that in some Windows versions, you may need to navi-
gate to Control Panel in a different way. However, once in Control Panel, 
double-click the Add/Remove Programs icon. If you don’t see the Add/
Remove Programs icon, you may need to click on the Classic View link or 
option. 

C. Select WComp2 from the program list within the Install/Uninstall tab. With 
the WComp2 item highlighted, click the Add/Remove button. 

D. When the Welcome dialog appears, click the Next button to begin the re-
moval process. 

E. The next dialog box to appear is titled Program Maintenance. Click the ra-
dio button next the Remove item, and then click the Next button. 

F. Remove the Program is the next dialog box to appear. The InstallShield 
Wizard will begin to remove the old WComp2 program when you click the 
Remove button. 
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G. You are notified when the removal function is complete. In the dialog box 
that appears, click the Finish button to close the InstallShield Wizard 

3. Install the New Version. The final step in the upgrade process is to install 
the new version by executing the file you downloaded. The name of the 
downloaded file is setupwcomp2.exe (note that sometimes the exe exten-
sion is hidden) and it is located by default at C:\Program Files\Puritas
\WComp2\. When you find the file, double-click on it and follow the instal-
lation instructions contained on page 5 of this manual. If you don’t know how 
to find the file, try following these steps: 

A Go to My Computer 
B Double-click the C:/ or Local Hard Drive icon. 

C Double-click the Program Files folder. 

D Double-click the Puritas folder. Note that you may be required to click 
the option Show Hidden Files in order to find the Puritas folder. 

E Double-click the WComp2 folder 



7 

Ohio Workers Compensation—Injured Workers Forms—Version 2+ 

 
Ohio Workers’ Compensation—Injured Workers Forms—Version 2+ (WComp2) 
starts by displaying the Main Window. After you get to know WComp2, you’ll dis-
cover that you can display and complete any form or worksheet in any order. For 
now, however, it is best to follow the logic and organization of the Main Window.  
 
Before getting into the actual steps involved in completing a set of probate forms, it’ll 
will help to understand a bit more about the Main Window and how it can help make 
completing forms and understanding program operation a lot easier. 
 
Main Window 
 
IMPORTANT NOTE. Even though we used the “Enter” graphic at the top of this 
page, do try to avoid using the <ENTER>  key to move from item to item. In Win-
dows, this is the purpose of the <TAB> key. We program the <ENTER> key to act 
like the <TAB> key for backward compatibility, but you should definitely get out of 
the habit of using <ENTER> for that purpose. 
 
You can also point to different areas of a form with your mouse to jump to remote 
spots of the form without needing to hit <TAB> or <ENTER> repeatedly. 
 

The Main Window 
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Main Window—Overview 
 
Tree View. The pane on the left side of the Main Window contains a tree view of all 
the forms and functions in WComp2. You should be familiar with the look and feel of 
the tree view because it is a standard Windows component. You may recognize it as 
part of the Windows Explorer user interface. You can do two things in the tree view – 
click on nodes or click on items. Also, if you ever cover the Main Window with a 
form and wish to see it again, you can click on the Main Window button on the but-
ton bar or use the Display menu's Main Window command. The vertical divider that 
separates the left window from the right can be dragged horizontally to adjust the 
relative sizes of these windows to your liking. 
 
Nodes. Nodes are the [+] or [-] buttons you see in front of certain items in the tree 
view. The [+] sign means that there are elements or subitems hidden within that item. 
You can view or expand the subitems by clicking on the [+]. When you do, you'll see 
the list of subitems and the [+] will change to a [-]. If you wish to collapse or hide the 
subitems, click on the [-]. Note that when you expand an item, its subitems may also 
have subitems. Even those subitems can have subitems. There's no limit to subitems 
in the tree view. You can see all of the items at the same time by right-clicking your 
mouse in the tree view and selected Expand Tree View from the pop-up menu. 
 
Items. Clicking on the items will display either (1) a relevant instruction page in the 
right-side window pane, or (2) a particular form that you wish to view or complete. 
 
Start Here. As mentioned earlier, even though you can click on any item in any or-
der, we've arranged the first level of subitems in a top-to-bottom order that logically 
organizes the data entry process. Click on the [+] to the left of the Start Here item to 
begin. You'll see the first level of subitems: 
 

General Information 
This single form contains a lot of background information. The sort of infor-
mation you'd like to print and staple to the inside cover of your client file. Ba-
sic claim information regarding the injured worker, the employer and their 
representatives. The information you enter on the General Information form 
is used again and again as WComp2 automatically completes the various 
forms you request. 
 
Name The File 
A reminder and ;quick access to the Save As dialog. It’s a good habit to save 
your file and give it a name as soon as possible. Having completed the Gen-
eral Information Worksheet, now is a good time  
 
Completing /Displaying Forms 
This item contains an expandable hierarchy that contains a link to all the 
forms, schedules, and other documents contained in WComp2 . It parallels the 
Display menu. Having completed the General Information Worksheet, 
some or most of the information will be completed. Carefully review  and, if 
necessary edit, each form that you want to print. 
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Printing Forms 
Clicking on this item takes you to the Print Selected Forms dialog from 
which you can print any single form or batch of forms. There are no subitems 
with respect to this item. 
 
Sending Forms to Your Word Processor 
Clicking on this item takes you to the Send Selected Forms dialog from 
which you can send any single form or batch of forms to your word proces-
sor. There are no subitems with respect to this item. WComp2 works best 
with Microsoft's Word for Windows, but can be used with most word proces-
sors capable of handling rich text format (RTF) files. When it ships, 
WComp2 is set to use Word for Windows. If you use a different word proc-
esser, you can go to the Options menu's Set Word Processor function to 
make the necessary adjustment. 
 

Getting Started. Assuming you've already clicked on the node [+] to the left of the 
Start Here item, you're ready to start on a file now. Click on the General Informa-
tion item to display the General Information Worksheet. 
 
Finally 
 

Upgrades. As you are probably already aware, the workers compensation 
forms change with time. Consequently, the need to perform upgrades, while 
not urgent, should be done at periodic intervals. Follow the detailed outline 
on pages 5 and 6 of this manual for information about upgrading.. 
 
Dates. Almost everywhere that a date is involved, WComp2 provides a con-
venient pull-down, date picker. If you prefer, you can still enter a date by 
hand, but make certain to use 4 digit years, i.e., "1985" instead of "85." Also 
note that you can change the year by clicking on the year at the top of the 
date-picker drop-down. The same is true of changing the month. 
 
Print This Page. This, and any other instruction page, can be printed by 
clicking on the Print button on the upper tool bar. 

 
1. Completing the General Information Worksheet. 
 
When you click on the General Information item in the Main Window’s tree, you are 
presented with the General Information Worksheet.  
 
IMPORTANT. Press <TAB> after every entry. 
 
The General Information Worksheet has one or two restrictions of which you 
should be aware. First, the Date of Birth field in the Claimant Information section 
should be entered in a MM/DD/YYYY format. If you don’t enter the year correctly 
you will receive an error message. 
 



10 

Ohio Workers Compensation—Injured Workers Forms—Version 2+ 

Another restriction deals with marital status. For WComp2 to process other areas of 
the forms correctly, enter the marital status as one of the following: Single, Mar-
ried, Divorced, Widowed or Separated. So long as you enter the injured worker’s 
marital status exactly from the list, WComp2 will be able to correctly complete areas 
of other forms that deal with marital status and related issues. Other minor restric-
tions are involved in fields that request numeric entries such as dollar amounts or 
times. In those fields, you’ll find that alphabetic entries are rejected by WComp2 
. 
It’s not necessary to go through every entry on the General Information Work-
sheet. The technique is simple. Make your entry and press <TAB>.  
 
TAB & SHIFT TAB. Although you may discover that you can press the <ENTER> 
key after each entry, we recommended you use <TAB> after each entry. Note also, 
however, that if you hold the <SHIFT> key down when you press <TAB>, you 
can move the focus backwards. 
 
2. Give the File a Name 
 
When you’ve completed the last entry on the General Information Worksheet, the 
text input box will return to the first entry at the top of the page. This is a good time 
to save your file and give it a name. Look at the title bar on your display and you’ll 
notice that we haven’t named the file yet. We are reminded of that fact on the title 
bar where it says NONAME. Don’t work in your file too long without giving it a 
name. After you’ve completed the worksheet, you’ll want to use the File|Save As 
command to give your file a name. You may use any valid Windows file name, but 
by all means, use the WC2 extension, or better yet, leave it off and let WComp2 add 
it automatically. Once the file has a name, you’ll see it on the window’s title bar. 
Avoid using the File|Save As command once you’ve given your file a name. 
Use the Save button on the button bar to save file changes AFTER you’ve used 
the Save As command to name the file. 
 
To recap, here’s three worthwhile rules to keep in mind when saving files: 
 
1. Always use the extension WC2. If you simply type the file name and don’t type 
the period and extension (WC2), the WComp2 will attach the extension automati-
cally and this is probably the easiest course to follow. 
 
2. Save your client files in the default WComp1 directory (C:\Program Files
\Puritas\WComp2\Files).  WComp2 is designed to open and save files to a single 
directory where all of the client files can be found. You can set the default directory 
using the appropriate command on the Options menu, but once you set the default 
location, use only that location for all your client files. 
 
3. Completing/Displaying the Forms 
 
The Display menu is the point from which you can display and complete all the 
other forms in the program. When you click on the Display menu, a list box appears 
containing a list of all the forms in order of their respective form number. To view a 
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particular form, you simply double-click on the form name or highlight the form (by 
single clicking on it) and pressing the Ok button. 
 
When you display a form, it should appear on your screen partially completed. That 
is, any information you entered on the General Information Worksheet should 
automatically transferred to the form you are viewing. Again, you merely make your 
entries and tab from field to field on the form until it is complete. We recommend 
clicking on the Save button every 10 minutes or so in order to protect your work. 
 
4. Printing Forms 
 
There are two ways to print forms. You can print the form you are displaying by 
clicking on the Print button on the tool bar below the menu bar. The other way to 
print forms is to click on the File menu’s Print submenu and select Selected Form. 
The Selected Forms dialog box will appear containing a list of the forms in 
WComp2. The forms are divided according to paper size (letter or legal). You can 
select any form or combination of forms and then press the Print button. WComp2 
will print the letter-size forms first. 
 
IMPORTANT. When the Print Setup dialog appears, make sure it is set to Letter 
size paper. When the letter size forms are done being printed, the Print Setup dialog 
will appear again and you must reset the paper size to Legal before continuing with 
the print job. 
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This paper manual is merely an outline of the basics of installation, getting started 
and data entry. From there, you can get help via the program’s Help|Table of Con-
tents menu. This program has context-sensitive help. That means that you get help on 
a specific topic without searching for that topic. 
 
Some dialogs have a help button. Clicking on the help button brings up an associated 
help topic that should clear up any questions you have about the entries you would 
make in that dialog. Menu items have context sensitive help too. You can access help 
on menu items by navigating to the menu item in question using the keyboard and, 
while the subject menu item is highlighted, pressing your <F1> key. Another useful 
feature of WComp2 is that when an error message or warning is displayed, in 
many instances the notice has a Help button that will take you to a related help 
topic explaining the error or warning. 
 
If you’re like us, you might be doubtful as to whether help files can be truly helpful. 
Regardless of  any drawbacks, we found them to have significant benefits over their 
paper counterpart. 
 
Help Is Always There 
When we were at the office, the manual was at home. When were on the computer at 
home, the manual was at the office. On unfortunate occasions, that alone can make 
you lose a day. It never happens with help files. They’re always there. A copy for 
your home computer, and a separate one for the office. Ditto for your laptop! When 
you’re desperate for information, you can always count on its accessibility. 
 
Help Is Hyperlinked, Searchable & Better Indexed. 
We took extra time to develop a logical system of indexing. You should find that a 
help file’s searchability can be a time-saver when you’re looking for a snatch of text. 
The point and click links between key words provide instant information without 
fumbling though page after page looking for something. This non-linear characteris-
tic is part of what makes help files so uniquely useful. 
 
Help Is Up To Date 
Because they are printed in larger quantities, paper manuals fall out of synch with 
last-minute or late-minor programming changes during the duration of the “printing.” 
Help files, on the other hand, are easier to keep current with programming changes 
because their modification involves no additional processing steps to implement (i.e., 
physical transportation, printing, binding, etc.). 
 
Paper Fix 
Don’t forget that any help topic can be printed simply by pressing the help window’s 
Print button, or using the menu’s Print Topic command. 
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Checking out the following help topics before working with 
WComp2 will help reduce the learning curve, although you 
should find WComp2 relatively straightforward to use. 
 
 
1. What is the DEFAULT.WC2 file? 
This topic explains how to customize the blank, start-up 
worksheet so that common, usually unchanging information 
is set up to appear automatically when you select New from 
the File menu.  
 
2. Overriding Answers 
You’ll use this command when you need to manipulate entries in text input dialogs 
that have a light blue background. 
 
3. Default WC2 Directory 
This command is used to set the location where your client files are to be saved. If 
you’re using WComp2 on a network and you have a multi-user license, you’ll want to 
glance at this topic. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Puritas Springs Software 
The Cleveland Trust Building 

Post Office Box 360170 
Cleveland, Ohio 44136-0003 

 


